
Studio 1 SDR 1.0 – Quick start guide 
 

1.0 Studio 1 basics and concepts 

 

1.1 Application instance 

 

Studio 1 can run in multiple instances, each with a different input device. 

The input device can be a soundcard (WME or ASIO), a pre-recorded IQ file or an external SDR 

receiving hardware (as Perseus, SDR-14, QS1R etc.) via ExtIO dll interface. 

Each Studio 1 instance stores and recalls its own settings. 

Please note: closing the instance #0 will close all the other instances as well. 

 

1.2 Main window 

 

The first time you run Studio 1 only this window is shown. The main window is the control 

center of a Studio 1 instance. Here you can open the VRX windows, enable/disable VRX, create 

and manage workspaces, change the instance settings, select the input source and sample 

rate (where applicable), open the recorder window etc. 

It can be closed or minimized to the task bar. 

 

1.3 Virtual Receiver (VRX) 

 

A VRX is a receiver implemented in software; each VRX takes the signal from the input device, 

processes it and outputs the demodulated signal to an output device of your choice (currently 

only WME devices are supported). Studio 1 can create and run multiple VRX inside the same 

application instance. When you run an instance of Studio 1, one VRX is always created: it is 

the “master” VRX or VRX #0. VRX #0 has some peculiarities: 

 

- can’t be disabled or deleted 

- it is the only VRX that can change the LO of the external hardware 

- it is (currently) the VRX used when playing IQ files* 

- it is (currently) the only working VRX when using the ASIO driver 

 

*Starting from release 1.05d it is possible to use multiple VRX while playing IQ files; see 2.12.  

 

A VRX includes four windows: SP1, SP2, RX Control, RX EX Control. 

 

SP1 is the “main spectrum” window: it shows the spectrum of the signal from the input 

device. This window is resizable and its settings are stored and recalled together with the 

relative VRX. Also it can be closed or minimized to the task bar. 

 

SP2 or “Aux spectrum” window: it shows the spectrum in the down-converted bandwidth. 

Here you can modify the selectivity filter, place notches etc. 

This window is resizable and its settings are stored and recalled together with the relative VRX. 

Also it can be closed or minimized to the task bar. 

 

RX Control is the VRX control center: here you can set the VRX output device, frequency, 

receiving mode and many more parameters. Its settings are stored and recalled together with 

the relative VRX and it can be closed or minimized to the task bar. 

 

RX EX Control groups additional controls for the VRX that are (generally) less frequently 

used. The purpose of this separation is to spare screen space when possible. Here you have 

access to all the parameters relative to notches, noise blanker, noise reduction, soft filter, SNR 

and more. These settings are stored and recalled together with the relative VRX and it can be 

closed or minimized to the task bar. 

 

Note: Each VRX stores and recall its own settings. 

 



1.4 Workspaces 

 

In Studio 1 a workspace is a data set of visibility information (position, size and show/hide 

status) relative to all the VRX, Main and Recorder windows used in an instance. 

Starting from release 1.03, the RDS Info window parameters of each VRX are also saved. 

Ten workspace memory positions are available in each instance (0 – 9). 

A workspace can be renamed. The first time you run Studio 1 the workspace #0 is recalled; its 

default name is “Default Workspace”. The last used workspace in a given instance is stored at 

program exit and recalled at the next start-up. 

 

2.0 Getting started 

 

2.1 Creating a workspace 

 

Once you have started Studio 1 you can try building a simple test workspace to practice with 

the operations involved. Each VRX has a corresponding row of buttons in the main window. 

From left to right you have: 

 

- the VRX number 

- the SP1 button (shows the Main Spectrum window of that VRX) 

- the SP2 button (shows the Aux Spectrum window of that VRX) 

- the RX button (shows the RX Control window of that VRX) 

- the VRX enable/disable button (a small squared coloured button) 

 

Since we have not created other VRX, only the VRX #0 row will be available. 

Left-click the SP1 button: the SP1 window will appear, with the default size and position. 

Now try to resize it: it can be done grabbing a border edge and dragging (as in usual Windows 

resize operations) or clicking and dragging the small button in the left-bottom corner of the 

window. Right-clicking on that button will popup a small preset menu where you can select 

among some common screen widths. Move the window clicking on the border (or any other 

part of the window outside of a control) and dragging. 

 

Now repeat the above operation for SP2 then click RX to open the RX Control window and 

move it to a suitable position.  If you whish you can also add the RX EX Control to your 

workspace: to show it click on the EXW button on the RX Control window. Once you are 

satisfied with your work you can save the workspace: click on the workspace name label in the 

main window (the label that is currently showing “Default Workspace”), the workspace 

selection will popup. To store your workspace in one of the ten positions available click on one 

of these while pressing the CTRL key. Done. 

 

2.2 Managing Workspaces 

 

In order to manage workspaces you have the following options: 

 

Save the current windows set to a workspace memory position: popup the workspace menu 

and Left-Click to a workspace name while pressing the CTRL key. 

 

Recall a workspace (making it the current workspace): popup the workspace menu and Left-

Click to a workspace name. 

 

Rename the current workspace: Right-Click on the workspace name label in the main window, 

enter the new name then press Enter to confirm or ESC to abort. 

 



2.3 Selecting an input source 

 

If you have an ExtIO dll in the Studio 1 folder and the relative hardware is connected and 

ready, it becomes the default input device; otherwise the default input device is the last 

selected WME driver (soundcard). The WME input and ASIO I/O device can be selected in 

Main->Settings->Input Tab; here you have also indication of the ExtIO dll loaded at start-up 

(if any). 

If no WME specific device has been selected, the system default (sound mapper) will be used. 

If you wish to use ASIO devices you must select an ASIO driver.  Input source selection is 

done on the Options menu: OPT->Select Input.  Let’s take as an example that you have a 

Perseus connected and the ExtIO_perseus.dll loaded. If the hardware is powered and ready, 

you should have it selected as the input source.  

 

2.4 Selecting an output device for a VRX 

 

As already seen in 1.3 each VRX can have its WME output device. More VRX can share the 

same WME device. Output device can be selected in RX Control->Settings->Out Tab. 

If no device is selected (default) the VRX will use the system default (sound mapper). 

 

2.5 Selecting input SR (WME and ASIO input only) 

 

Input SR selection is done in Main->SR button: the SR menu will popup. 

 

2.6 Starting the DSP engine 

 

Now you are ready to test your setup: click on the big button “START” in the main window. 

You should hear noise or demodulated audio and the spectrum windows should also work. 

 

2.7 Setting the RX frequency 

 

You have multiple choices for inputting a frequency value: 

 

- Clicking on one of the band buttons (under the S-meter in the RX Control window). 

- Moving the cursor to a specific digit in a frequency dial (inside the RX Control window or 

inside SP1 if the dial is enabled) and turning the mouse wheel. 

- Using the current tuning step turning the mouse wheel (when the cursor is outside any 

control and one of the VRX windows has focus). 

- Entering the frequency directly with the mouse and/or the keyboard. 

- Clicking on the Main Spectrum window (spectrum or waterfall); from release 1.03 the 

actual selected frequency is the nearest multiple of the current tuning step. 

- Using the Memory Banks features (from release 1.04); see section 10 of this guide. 

- Using a dedicated hardware controller (Tmate – Tmate 2, see section 9 of this guide). 

- Using CAT control and/or Omnirig (see section 8 of this guide for details).  

 

2.8 Changing the tuning step 

 

Right-click on the RX Control frequency dial: the dial step menu will popup. Select the desired 

tuning step. 

 



2.9 Entering frequency directly 

 

If you wish to use the keyboard one of the VRX windows must have the focus. 

In order to enter a frequency directly with the keyboard and/or mouse: 

 

- Press the SPACE bar or click on the RX Control frequency dial; this will start the input 

sequence. The dial will display 0 and the white frame around the dial will turn to yellow. 

In order to abort the input sequence press the ESC key or click on the Clear button in 

the RX Control window. 

- Enter the frequency in KHz using the numeric keys and/or clicking on the band buttons. 

If you wish to enter Hertz values use the decimal separator of your system. For 

example if you wish to enter 1455202 Hz type in 1455.202 (or 1455,202 depending on 

the system). Note: starting from release 1.02b you can use whatever decimal separator 

you wish; the program will replace it automatically (if needed) with the correct one. 

- Press Enter or click the Enter button in the RX Control window. If the value has been 

accepted the dial will show the new frequency. 

 

2.10 Minimize/Restore All option (from release 1.02b upwards) 

 

As the Studio 1 GUI is made of many independent windows, an option to minimize or restore 

all the windows of an instance with a single action can be very handy sometime. 

The “minimize-restore all” option is controlled by the small “MA” button located in the upper 

left of the Main window. When enabled, minimizing or restoring the RX Control or the RX EX 

Control window will result in minimizing or restoring all the opened windows in the relative 

Studio 1 instance. 

 

2.11 VRX background (from release 1.05 upwards) 

 

The VRX background colour can be customized by the user; the relevant control is located 

here: RX Control window->SETT.->MISC->VRX BACKGROUND COLOUR . 

Currently this parameter only affects the spectra (MAIN SP and AUX SP) background. 

In the future the functionality will be extended to all the VRX windows.  

 

2.12 Using multiple VRX while playing IQ files 

 

Starting with release 1.05d Studio 1 allows the use of multiple VRX while playing IQ files. 

A new option has been added: Main window->SETT.->MISC->MULTI VRX WAVE FILE MODE . 

The above option is enabled by default; if you wish to use only VRX#0 (as in the previous 

versions of Studio 1) uncheck the option. 

 

 

2.13 RDS  

 

Release 1.05e features a totally re-designed RDS demodulation processing, from filtering to 

bit-stream extraction. Also a new “DX mode” feature has been added to the RDS decoder. 

The new RDS processing offers “state of the art” performances, very close to the theoretical 

limits. Testing has shown that it is still possible to obtain a valid RDS PI from a signal with only 

a 10 dB S/N ratio.  

 



2.14 About RDS mode selection 

 

Studio 1 RDS demodulation/decoding works in WFM and SWFM modes. There are three 

operation modes for the RDS system: OFF, Mode1 and Mode2. You can select a specific mode 

for a VRX in the RX Control->SETT.->RDS window. 

 

• Off: the entire RDS sub-system is shut down; this can be useful to save CPU. 

 

• Mode1: the demodulator directly locks a special PLL to the 57 KHz RDS sub-carrier in 

order to extract the modulating bi-phase signal. This allows for RDS reception of any 

kind of signals, including mono, providing they contain a valid RDS modulation. This is 

the default mode. 

 

• Mode2: the demodulator uses the third harmonic of the stereo pilot in order to extract 

the modulating bi-phase signal. This mode only works with stereo signals and uses less 

CPU than Mode1. 

 

Note: starting from release 1.06 this mode is no longer available as in practice Mode 1 

always offers superior results. 

  

 

2.15 RDS “DX-mode” (starting from release 1.05e – updated in 1.05f) 

 

RDS data is transmitted in pieces called “RDS groups” and each group is composed of four 

“RDS blocks”. To obtain valid data the RDS decoder must achieve “synchronization” first; this 

means that a correct sequence of blocks “A” to “D” must be validated by the embedded error 

correction system. In very poor S/N ratio (approximately below 11-12 dB) this is impossible. 

In normal use this is usually not a great concern but for DX enthusiast it is, as the main goal is 

the identification of the broadcaster by the RDS PI data. PI data is embedded at least in all 

“Block A” of any RDS groups so it is one of the more redundant pieces of information 

transmitted. In RDS “DX-mode” Studio 1 tries to extract the PI by attempting a partial 

synchronization, then the relative PI data is shown in red. The level of confidence is very high 

(> 99.5%). The RDS decoder exits “DX-mode” once full synchronization is achieved and the PI 

label returns to its normal state. In order to re-enter DX-mode you have to reset the decoder 

by the RESET button in the RDS Info window. DX mode behaviour has been modified in Rel. 

1.05f (see the QS guide provided with Rel. 1.05e). For marginal signals DX-mode can be a 

very useful tool. 

 

 

2.16 IQ Wav files maximum length 

 

Studio 1 versions prior to 1.05e record IQ wav files of a maximum length of (about) 2 millions 

bytes, as did WinRad/WRPlus. Starting from release 1.05e the user has an option to define his 

custom file length up to 4 gibibytes (10243 bytes) which is the limit of the wav format itself. 

In fact, in the Wav file header size is stored as a 32 bit unsigned integer so the storable 

maximum size is 2^32 bytes. In the future Studio 1 will offer the option to store IQ data in 

another format, without the above limitations. Please note that the advantage of keeping the 

wav format is compatibility: Studio 1 files can be opened with any tools that support that file 

format. To change the default file size (2048 mebibytes) go to Main->SETT.->MISC, double 

click on the “WAV FILE MAX RECORD LEN” and enter the new size, then press Enter to confirm.



3.0 “Hidden” functions in Studio 1 

 

3.1 Selecting the recording folder 

 

Right-click on the Recorder button in the Main window or on the Recorder window: this will 

popup the folder selection window. 

 

3.2 Using the custom controls  

 

Studio 1 implements some custom controls specifically created for it. 

 

Sliders 

 

Sliders are used for some parameters such audio level, squelch level etc. 

You have several options to modify a slider value: 

 

- For quick, large changes simply click in the new position of the slider 

- For continuous variations click and drag. 

- For fine, precise control put the cursor inside the slider and turn the mouse wheel 

 

Wheel Edit Dials 

 

These controls are easily recognizable as their background turn to purple as you place the 

cursor above them; some examples are the notch filters BW and Freq. controls in the “RX EX 

Control” window. In order to change the value of one of these controls, you must place the 

cursor inside it, then you have several options (here is an example for a notch Freq. control – 

actual steps depend upon the specific function): 

 

- Turning the mouse wheel will change the value in +/- 1 Hz steps 

- Turning the mouse wheel while pressing the SHIFT key will change the value in +/- 10 

Hz steps 

- Turning the mouse wheel while pressing the CTRL key will change the value in +/- 0.1 

Hz steps 

- Right-clicking will change the value in + 100 Hz steps 

- Left-clicking will change the value in - 100 Hz steps 

- Right-clicking while pressing the SHIFT key will change the value in + 1000 Hz steps 

- Left-clicking while pressing the SHIFT key will change the value in - 1000 Hz steps 

- Right-clicking while pressing the CTRL key will change nothing (not used in this case) 

- Left-clicking while pressing the CTRL key will change nothing (not used in this case) 

 

3.3 The spectrum “quick browser” 

 

Sometimes in a spectrum window you need a high zoom factor and at the same time you need 

also to move quickly to another part of the spectrum; as the shown spectrum portion is small 

in comparison to the total it would take ages to reach the wanted position dragging the 

frequency scale. 

So for Studio 1 we have invented the “quick browser” function: 

 

- Place the cursor inside the frequency scale. 

- Press the SHIFT key, a yellow overlay will appear on a portion of the scale: here the 

size and position of this overlay indicates the currently shown portion of the spectrum 

relative to the total (the whole frequency scale). 

- Click and drag the above overlay until the window shows the spectrum portion you 

wish. 

 



3.4 SP2 filter adjustments 

 

Besides the usual dragging of the selectivity filter edges (the red cursors) in the SP2 window 

there are other some useful features available. 

 

Asymmetrical adjustment 

 

Usually in AM, SAM (DSB) and FM mode, dragging one edge has the effect of controlling 

simultaneously the other in order to create a symmetric filter (around 0). In Studio 1 the 

selectivity filter high and low frequency parameters can be different. If you wish to set up an 

asymmetrical filter drag one edge while pressing the CTRL key. 

 

Pass band Tuning 

 

Put the cursor in between the filter red cursors. Right-click and drag: this will have the effect 

of moving both the filter edges (pass band tuning). 

 

3.5 S-Meter function 

 

In order to change the S-Meter function to FM tuning meter and vice versa, simply click on it. 

 

3.6 Temporary LO Lock 

 

Changing the hardware LO has the effect of changing the tuning frequency of all the active 

VRX. This happens when you change the tuning frequency of VRX #0 (the master RX). 

If you wish to change the frequency of VRX #0 without changing the hardware LO you can use 

the LO LOCK button in the Main window. But if you need only a temporary lock simply press 

the SHIFT key while tuning. 

 

3.7 Quick recording 

 

Studio 1 includes a feature to put a Studio 1 instance in recording mode “on the fly”, without 

opening the Recorder window. When you wish to start recording simply press ‘*’ on the 

keyboard (the relative Studio 1 instance must have the focus). 

 

3.8 CW pitch (CW shift) 

 

In CW receiving mode a VRX uses a frequency offset in order to obtain a CW note. 

This offset can be set as follows: 

 

- Make sure you have the DSP engine running (so to have the spectrum windows 

updated). 

- Select CW receiving mode. 

- Place the cursor in the spectrum part of the Aux Spectrum window (SP2); a green 

vertical line will be shown at cursor position. 

- Choose your new CW pitch moving the above line to the corresponding mark on the 

frequency scale; a positive value will set a “lower than carrier” offset (USB-CW) while a 

negative value will set a “higher than carrier” offset (LSB-CW). 

- Assign the new offset by Left-Click while pressing the CTRL key. 

 



3.9 Quick notch frequency setting and the notch-lock function 

 

Each VRX offers four notch filters to suppress unwanted signals, placed before the AGC. 

Each notch filter can be enabled/disabled by the relative button in the RX Control window. 

The notch filters BW e Frequency settings are available in the RX EX Control window. 

For notch filters 1 e 2 the frequencies can be quickly set “on the fly” as follows: 

 

- Place the cursor in the spectrum part of the Aux Spectrum window (SP2); press and 

hold the SHIFT key: a yellow vertical line will be shown at cursor position. 

- Move the above line next to the signal you wish to suppress. 

- Assign that frequency to Notch 1 by Left-Click or Notch 2 by Right-Click. 

- Release the SHIFT key. 

- For each enabled notch the relative frequency is marked in the spectrum by a dotted 

vertical line, light-blue for Notch 1 and light-pink for Notch 2. 

 

The NCHL button in the RX Control window enable/disable the notch-lock feature. 

When notch-lock is active, the notch filters frequencies are updated when the receiving 

frequency is changed. 

 

Let’s see the purpose of the Notch Lock function in a typical usage scenario: you are following 

a SSB QSO where some operators are each other slightly off frequency, requiring retuning for 

good audio. At the same time you are using a notch filter to kill a heterodyne tone caused by a 

nearby emission. Without notch-lock you should re-adjust the notch filter(s) frequency every 

time you retune; notch-lock does this for you automatically. 

 

3.10 Adjusting the proportion of spectrum and waterfall displays 

 

Inside SP1 and SP2 windows, for the SP+WF display mode you can alter the proportion of the 

SP vs. WF by right-clicking the frequency scale and dragging it vertically to the desired 

position. 



3.11 Keyboard shortcuts 

 

Key: Function: Scope: 

A - a Select AM rx mode VRX(1) 

S - s Select SAM rx mode VRX(1) 

F - f Select FM rx mode VRX(1) 

C - c Select CW rx mode VRX(1) 

D - d Select DSB rx mode VRX(1) 

L - l Select LSB rx mode VRX(1) 

U - u Select USB rx mode VRX(1) 

E - e Select User rx mode VRX(1) 

N - n Select NFM rx FM sub-mode VRX(1) 

M - m Select MFM rx FM sub-mode VRX(1) 

W - w Select WFM rx FM sub-mode VRX(1) 

O - o Select SWFM rx FM sub-mode VRX(1) 

T - t Toggle Rx/Tx mode(4) VRX(4) 

SPACE Starts direct frequency input seq. VRX 

Enter Closes direct frequency input seq. VRX 

ESC Aborts direct frequency input seq. VRX 

   

CTRL+F Show/hide the files pane Memory Panel(2) 

CTRL+S Store enabled VRX to memory 

location (same as STORE button) 

Memory Panel(2) 

Ins Inserts a new row after the current Memory Panel(2) 

Del Deletes the current row Memory Panel(2) 

F2 Starts editing the current cell Memory Panel(2) 

CTRL+S Store specific VRX to memory 

location 

VRX(2) 

   

* Starts IQ file recording Instance(3) 

H - h Shows the ExtIO panel (if loaded) Instance(3) 

B - b Shows the Memory Panel window Instance(2) 

 

Note 1: From release 1.02c upwards. 

Note 2: From release 1.04 upwards. 

Note 3: Controls not available when the Memory Panel has focus. 

Note 4: From release 1.06 upwards; see 8.8.



3.12 The I/O Sample Rate difference issue 

 

Using different physical input and output devices means that there is no synchronization 

between the I/O sample rates; further more, a small deviation (in the order of less of ten to 

some hundreds of PPM) from the theoretical rates exists. 

SDR programs (including Studio 1) use memory buffers as “dampers” that absorb those 

differences; however, sooner or later the buffers will be all filled (overflow) or all empty 

(underflow), depending upon the sign of the combined input and output deviations. 

With typical hardware this can happen after several hours of continuous processing. 

At that point the program will re-establish the correct buffering, trashing some data and 

creating a small “gap” in the output stream. 

Off course there is a way to prevent this, implementing a complex closed loop servo system 

that monitors the buffering and controls an output fractional resampler. 

Studio 1 can do this and it works very well, ensuring that no data are lost at any time. 

However, when the above system is enabled a small frequency modulation of the output signal 

occurs (in the order of a fraction of Hz when the servo has settled down). 

In some sensitive applications (APT e other critical signal post-decoding), this small modulation 

can sometime cause problems; in Studio 1, starting from release 1.03 there is an option to 

disable the output resampler: RX Control ->SETT.->OUT->Lock Output Fractional Resampler. 

Per default the output fractional resampler is enabled.  

 

 

4.0 Synchronous AM 

 

Studio 1 implements a high performance SAM mode. When you select SAM the last used sub-

mode is also recalled (LSB, USB or DSB). Once SAM is engaged you can switch to the desired 

sub-mode by clicking the relative buttons: 

 

- LSB: lower sideband SAM 

- USB: higher sideband SAM 

- DSB: double sideband SAM 

 

LSB and USB SAM sub-modes share the same selectivity filter settings while DSB has its own 

settings. Some common filter settings are available as presets in the RX Control window. 

Off course you can set the filter manually as indicated in 3.4. 

Automatic volume compensation is performed while switching from LSB or USB to DSB. 

To leave SAM mode you can either click on the SAM button again (this will select the last used 

SSB mode) or select any other reception mode. 

 

4.1 SAM: what is new? 

 

In Studio 1 the SAM PLL has its own AGC and selectivity filter. There are many advantages in 

using this configuration: 

 

- The demodulation AGC timing can be optimized for listening while a much faster PLL 

AGC can cope with fast, deep fading 

- The PLL selectivity filter can be made very narrow in order to allow only the wanted 

carrier passing thru; this way little noise reaches the PLL and the lock on noisy signal is 

much improved 

 

The PLL step response can be set to two different modes: 

 

- FAST: this is the default mode; in "fast" mode the PLL can track phase-modulated 

carriers that contain embedded data streams (for example BBC on 198 KHz), avoiding 

the demodulation of those noisy unwanted signals. Lock time is fast even if you are off-

tune but the PLL is also more sensitive to noise given the wider loop bandwidth. 

 



- SLOW: this is definitely the DX choice; lock time is slower and the PLL is much more 

immune to noise. This mode combined with a narrow PLL BW filter setting gives 

exceptional lock stability on very noisy signals. 

 

Locking range is limited with this setting: if this is a problem, first select FAST mode 

then switch to SLOW if required. 

      

 

The pre-PLL pass-band filter can be adjusted from +/- 50 Hz to the full bandwidth available. 

Please note that this setting also limits the range in which the PLL can achieve lock: for 

example if you are using a 500 Hz setting (default) and you tune outside the +/- 500 Hz from 

the carrier, the PLL will never lock as the carrier is filtered out. 

 

All the PLL AGC parameters are pre-fixed for best results minus the release time. This 

parameter can be optimized for the specific reception condition; usually the default value 

works well. 

 

All the SAM settings are available in RX Control->Settings->SAM/HP Tab. 

 

 

5.0 Frequency calibration 

 

In Studio 1 the hardware frequency calibration can be done in Main Window->Settings->Cal-

>HW LO Freq. Calib. There you can input a value in Parts Per Million; that value will be positive 

if the hardware oscillator is lower than its nominal frequency or negative otherwise. 

You can do the calculation of the compensation value at any frequency but best accuracy is 

achieved using the upper tuning range of the hardware. You need a reference signal whose 

frequency is known and accurate (for example in HF could be WWV on 15000 KHz). 
  
Let’s see an example using CHU (14670 KHz) as reference: 
  

- Using the Aux Spectrum window with a high zoom factor tune carefully the reference 

signal until you have the carrier at 0 Hz in the spectrum.  

- Read the frequency indicated on the dial. In this example it is 14670082: this means 

that the reference oscillator in your hardware is lower than its nominal value. 
- Compute the error as 14670082 – 14670000 = 82 Hz. 
- Compute the PPM compensation value as 82 * 1000000 / 14670000 = 5.590 
- Insert the above value in the HW LO Freq. Calib. edit box and press the Enter key. 
- Retune the reference frequency and check that the calibration is effective. 

 

 

6.0 S-Meter calibration 

 

Each hardware scales the input signal to its digital output in a different way, so Studio 1 

provide a way to have accurate S-Meter and dBm readings. This setting is available in 

Main Window->Settings->Cal->S-METER CALIBRATION. Here you can enter a +/- 99.9 dB 

value: a positive value will make the read value higher. We are collecting calibration values for 

the most common hardware. 

If you wish to make your own measurements we suggest selecting the RMS mode for the S-

Meter and dBm readings. For Perseus a suitable value is 16.0, for the Elad FDM-S1 is 14.0. 

 

 



7.0 External converter offset 

 

Up to four converter offsets can be stored in each instance of Studio 1. 

Offset settings are available in Main window->Sett.->OFFSET. 

 

Changing a converter frequency offset 

 

Enter the new frequency in the edit box to the left of the relative button then press the ENTER 

key. 

 

Enabling a converter offset 

 

Click on the relative offset button. 

 

Disable active offset 

 

Click on the NONE button. 

 

Inverted spectrum mode 

 

Some converter is designed so that its LO frequency is greater than the input signal frequency; 

because of this the output spectrum is inverted. In such case the inverted spectrum mode 

must be activated, clicking the INV button. Also the I and Q channels must be swapped (Main 

window->OPT->Swap I and Q Channels).  

 

 

8.0 CAT (from release 1.02 upwards) 

 

CAT control has been around for at least 25 years so it is a well known technology: there is no 

need to review the basics here but a little refresh may be useful to understand how CAT has 

been implemented in Studio 1. 

 

Whatever CAT protocol we choose, there is always a controlling device and a controlled one. 

In origin controlling devices were PCs and controlled devices were physical radios (receivers or 

transceivers) and accessories (rotors, switches, amplifiers etc.). 

Physical communication ports (serial ports for example) were used for the data exchange. 

 

Per definition, in a CAT session only the controlling device can initiate a transaction. 

For example, the PC might send a “give me the VFO A frequency” while the radio might reply 

“the VFO A frequency is 3561230 Hz”.  

 

The logical roles can’t be exchanged. 

 

Now that we have software radios (like Studio 1) a CAT session can be no more necessarily 

only between a program inside a PC and an external device but can be also between different 

programs inside the same PC (and even in different PCs).  

 

In order to achieve this we need a way to interconnect programs; one common solution is 

using special software tools to create “virtual com ports” pairs interconnected with “virtual null 

modem” cables. Then applications can see the virtual com ports as real ones, using them for 

communication. More on virtual ports later. 

 

Another requirement we need is that the software radio must “impersonate” a controlled 

device and react the same.  

 



8.1 How Studio 1 implements CAT 

 

We have designed the CAT in Studio 1 so that the application can act as a controlled device 

and a controlling one at the same time. More precisely, each VRX can be seen as a separate 

radio on a different com port while at the same time it can control a physical external device 

via Omnirig (starting from release 1.05g beta, see 8.5). 

 

For CAT radio emulation we chose a sub-set of the extensive Kenwood command set. 

The following VRX parameters can be set and read: 

 

- VFO A Frequency 

- VFO B Frequency 

- Active VFO (A – B) 

- RX Mode 

- AF level 

- Squelch level 

- S-meter (read only) 

 

Also several commands are implemented in a dummy way just to make some controlling 

programs happy (HRD for example). 

 

A detailed list of the implemented commands will be issued soon. 

 

 

8.2 VRX CAT parameters 

 

VRX CAT parameters are accessible here: RX Control->SETT.->CAT. 

 

COM DEVICE 

 

This combo box allows you to select / enter the serial communication device. 

It is possibly to choose among COM1 -> COM20 using the drop-down list. 

If the desired device has a name that it is not listed, enter it directly as follows: 

 

- select the text inside the control (double click on the text) 

- enter the device name by the keyboard 

- press the Enter key on the keyboard 

 

Default: COM10 

 

BAUD RATE 

 

This combo box allows you to select the speed for the serial device. 

This setting must match that of the controlling program, the higher the better. 

It is relevant only if the emulated virtual port has the “emulated baud rate” option enabled, 

otherwise it can be ignored. 

 

Default: 57600 

 

RX MODE CTRL 

 

This option let you to choose if the controlling program can set the VRX RX mode. 

 

Default: enabled 

 



ENABLE & CONNECT 

 

This option enables CAT and starts the connection to the selected com device. 

Once enabled, the connection is effective until disabled or until the deletion of the relative 

VRX; also the connection is performed automatically every time the VRX is created. 

The status of the connection is indicated by the label placed on the bottom of the window 

(STATUS: CONNECTED – NOT CONNECTED). 

To save system resources, do not enable unused connections. 

 

8.2 Creating virtual com ports 

 

In order to create virtual com ports you need a specific tool. 

Among the most used there are “com0com” (available free under GPL licence) 

http://sourceforge.net/projects/com0com/ 

 

and “VSPE” (free licence for 32 bit platform x86) 

http://www.eterlogic.com/Products.VSPE.html 

 

8.3 Example: connecting to Ham Radio Deluxe 

 

Start creating a pair of virtual com ports named COM10 – COM11; do not select the “emulated 

baud rate” (you need to do this only once). 

 

Launch Studio 1; assuming we whish to control VRX#0, open the CAT settings of that VRX. 

COM10 is selected per default; check “ENABLE & CONNECT”, the status should change to 

“CONNECTED”. Close the RX Settings window. 

 

Launch HRD; click on “Connect”. The first time you need to create a new radio connection: 

select “Kenwood” as “Company” and TS-440S (for basic controls) or TS-480 (for additional AF 

gain, squelch level and S-meter controls) as radio type. Select COM11 as “COM Port” and click 

“Connect”. 

 

Once the connection has started you can try to change frequency, mode etc. 

 

In other programs select a generic Kenwood as radio or the above models. 

 

8.4 Applications 

 

- Log applications 

- Frequencies databases 

- Digital modes decoders 

- Satellite tracking 

- Special controllers  

- Others 

 

8.5 Studio 1 as the controlling device – Omnirig  

 

Starting from release 1.05g, Studio 1 can control other devices (via CAT) thru the Omnirig 

COM server, a brilliant utility developed by Alex Shovkoplyas, VE3NEA of Afreet Software, Inc. 

The main purpose (and advantage) of Omnirig is to provide a common “transparent” interface 

to applications; the controlling application doesn’t have to deal with a specific radio but instead 

sends and receives commands to Omnirig that in turn acts as a “bridge”. Omnirig can be 

“instructed” to work with a specific radio by “rig description” files that are relatively simple to 

create. There is already a huge list of supported devices and others can be added when 

needed, without the need to modify the code of neither Omnirig nor the application using it. 

In the past years Omnirig has become a standard and a huge list of applications relies on it: it 

is freeware, reliable and easy to install and set-up. For details please see the Omnirig web site 

http://www.dxatlas.com/omnirig/ . 



8.6 Omnirig installation and set-up 

 

Probably you already know about Omnirig and you have already installed it on your system: if 

not please download Omnirig from http://www.dxatlas.com/omnirig/ . Installation is straight-

forward: just launch the installer and follow the instructions. Omnirig can control up to two 

devices at once (and so Studio 1, see below), RIG1 and RIG2; both must be configured in the 

Omnirig control panel. If your rig is not listed among the available rig types do a search on the 

web for a suitable rig description file, then add it to the “Rig” folder, located inside the Omnirig 

installation folder. Some setup tips: for best responsiveness use the higher baud rate your rig 

supports and set the polling interval to 100 mS. Please note that Omnirig can also see non-

physical devices thru virtual COM ports (other applications for example). 

 

8.7 How Studio 1 handles Omnirig 

 

As you know Studio 1 is a multi instance environment; for better control and efficiency Studio 

1 filters all the traffic from/to its VRX(s) to/from Omnirig thru an internal own “server”. 

The latter is created in the Studio 1 instance #0. Omnirig can control up to two devices at 

once; at a given time only one VRX, of whatever Studio 1 instance is allowed to connect to an 

Omnirig device (RIG1 or RIG2); a mutual exclusion logic prevents overlaps. In short, up to two 

VRX can connect to Omnirig at the same time, one per device. 

 

8.8 Monitoring Omnirig status from Studio 1 instance #0 

 
A monitoring feature is available from Studio 1 instance #0; go to Main�SETT�ORIG. 

Look at the bottom label first: this is the status of the connection to Omnirig; if Omnirig is 

correctly installed the label must show “Connected to OmniRig server”. If there are problems 

“Can’t connect to the OmniRig server” is shown instead: if this is the case recheck Omnirig 

installation. For each Omnirig device additional information are shown (only RIG1 is described, 

the same applies for RIG2): 

 

RIG1 Type: 

 

Shows the RIG1 device type currently configured in Omnirig. 

 

RIG1 Status: 

 

Shows the RIG1 status reported by Omnirig; if there is an active, working connection the 

status is “On Line”. Other status include “Rig is not responding” and “Rig is not configured”. 

 

RIG1 Used By: 

 

Shows which Studio 1 VRX is currently connected to RIG1 (instance # and VRX #). 

 

8.8 Which parameters are synchronized  

 

The following parameters are sent/received from Studio 1 to/from the controlled device: 

 

Omnirig Studio 1 Note 

VFO A frequency VFO A frequency If the controlling device has only one 
VFO, VFO A is used 

VFO B frequency VFO B frequency  

VFO selection VFO selection A - B  

Modulation mode Modulation mode Optional 

RX-TX status RX-TX status Mute the VRX in TX, see below 

   

 

Note: if the controlled device is a transceiver or transmitter, putting it in TX mode causes the 

VRX to enter a special mode: a yellow label “RF MUTE” shows up in the RX Control window, the 



MUTE button (AF muting) is activated and a 60 dB attenuation is applied to the signal after the 

SP1 display (so that real input levels are still shown) to facilitate AGC recovery. As the device 

exits TX mode the VRX returns to normal mode. Starting from release 1.06, you can use the 

key shortcut “T” to toggle the RX-TX modes of a synchronized transceiver/transmitter 

(provided that the “SYNC VRX -> RIG” option is enabled, see below); this feature can be useful 

also if there isn’t a synchronized device as it also toggles the RF MUTE status in the relevant 

VRX.  

 

8.9 Omnirig related VRX options 

 

Several options control the VRX/Omnirig connection; they are VRX parameters and must be 
set on a VRX basis. To access these parameters go to RX Control�SETT�ORIG. 

 

RIG SELECTION 

 

These buttons select the target device, RIG1 or RIG2. This setting also changes the name of 

the RSYN button on the RX Control window to reflect the selection (RSYN1 or RSYN2). 

 

Default: RIG1. 

 
SYNC VRX ���� RIG  

 

If checked, the controlled device is synchronized to the VRX (the device reflect changes made 

on VRX).  

 

Default: checked. 

 
SYNC RIG ���� VRX 

 

If checked, the VRX is synchronized to the controlled device (the VRX reflect changes made on 

the controlled device). You must enable this option to use the muting on TX feature (see 8.8). 

 

Default: unchecked. 

 

SYNC CENTER FREQ. (LO) 

 

If checked, the frequency information is relative to the VRX “center frequency” (the SDR 

hardware local oscillator). You must enable this option if the controlled device is also the front-

end of the receiving chain that includes Studio 1.  

 

Default: unchecked. 

 

SYNC RX MODE 

 

If checked, the modulation mode is also synchronized. 

 

Default: checked. 

 

8.10 The RSYN button 

 

The RSYN button on the RX Control window activates the synchronization of the relative VRX 

with the selected Omnirig device. A mutual exclusion logic avoids multiple VRX accessing the 

same device at the same time. The status of this button is persistent between sessions. 

 

 



9.0 Tmate and Tmate 2 

 

Studio 1 natively supports the Tmate controllers from WoodBoxRadio. As the Tmate drivers are 

“single client” we had to develop a way to make full use of the controllers in the “multi 

instance” Studio 1 environment: this has been achieved by implementing a “Tmate server” and 

using inter-process communication (IPC). 

 

9.1 What I need to use Tmate (and Tmate 2) with Studio 1? 

 

First you need to connect the Tmate to a free USB port. For Tmate you need also to install its 

driver while for Tmate 2 this is not necessary (Tmate 2 is a HID device so it uses a system 

standard driver. The following files (supplied with Studio 1) must be included in your Studio 1 

folder(s): 

 

- For Tmate: ELAD_Encoder.dll.  

- For Tmate 2: TMATE2_DLL.dll.  

 

If Studio 1 doesn’t find the needed dll it disables the server and reports the status in the 

Tmate settings window (see below).  

 

9.2 The Tmate server 

 

The Tmate server implements bi-directional communication between the Tmate and whatever 

VRX you like, even across multiple application instances (more on this later). 

Think of the Tmate server as a “global resource”; it is created (if needed) by the Studio 1 

instance #0. The process is off course entirely transparent to the user. 

 

9.3 Tmate server options 

 

The Tmate server options are accessible only from the Studio 1 instance #0 from here: 

Main window->SETT.->TMATE. 

 

ENABLE SERVER 

 

This checkbox enable/disable the Tmate server; the server status is reported on the window 

bottom: once enabled, if everything is ok you should read “Tmate server running.”. 

If the program reports an error, first check that no other application has allocated the Tmate 

(remember, Tmate is “single client”).  

 

Default: disabled  

 

AUTO ASSIGN 

 

This checkbox let you choose between two “assigning” options for the Tmate controller. 

 

If AUTO ASSIGN is checked, the VRX controlled by the Tmate is the one that currently has one 

of its SP1, SP2, RX Control or RX EX Control windows focused (the “Studio 1” label in the 

window plate is red). This is the simplest and fastest way to assign the Tmate controls to a 

VRX. 

 

If AUTO ASSIGN is unchecked, you have to assign the Tmate to a specific VRX by the “TCTR” 

button located on the upper-right border of the relative RX Control window. 

To avoid confusion, a mutual exclusion logic is implemented: only one VRX can be assigned at 

a given time. 

 

Default: enabled 

 



TMATE 2 

 

This checkbox let you choose between the two Tmate models. You can have both a Tmate and 

a Tmate 2 controllers connected to the system at the same time. In order to change this 

setting the Tmate server must be stopped (uncheck ENABLE SERVER). 

 

Default: disabled (controller type is Tmate) 

 

TMATE 2 USES VRX BACKG. 

 

The Tmate 2 controller features an LCD display with a RGB backlit.  

This checkbox let you choose between two backlighting modes: 

 

If checked, the LCD backlighting colour follows the assigned VRX background colour. 

 

If unchecked, the LCD backlighting is set to a fixed neutral colour. 

 

Default: enabled  

 

9.4 Tmate controls 

 

Currently the Tmate controls are implemented as follows: 

 

TUNING KNOB 

 

Tmate employs a 128 steps/turn optical encoder. Each step corresponds to a given 

increment/decrement of the VRX tuning frequency and it is the same used for the mouse 

wheel (see 2.7 – 2.8). The current tuning step is shown in the RX Control window to the left of 

the frequency dial. When the spinning speed exceeds a certain threshold, a multiplying factor 

of 5X is applied to the current step; this feature is quite common in traditional (hardware) 

receivers and transceivers. The knob can be locked (see below). 

 

F1 – DECREASE STEP 

 

This button decreases the tuning step to the next lower value (if available). 

 

F2 – INCREASE STEP 

 

This button increases the tuning step to the next higher value (if available). 

 

F3 – KNOB LOCK 

 

This button locks/unlocks the tuning knob; the locking status is indicated in the RX Control 

window, to the left of the frequency dial. 

 

F4 – MUTE 

 

This button has the same effect of the MUTE button inside the RX Control window. 

 

Please note that the tuning step, lock and mute options are independent for each VRX. 

 



9.5 Tmate 2 controls 

 

Currently the Tmate controls are implemented as follows: 

 

Rotary encoders: 

 

MAIN ENCODER (TUNING KNOB) 

 

Tmate employs a 32 steps/turn encoder. Each step corresponds to a given 

increment/decrement of the VRX tuning frequency and it is the same used for the mouse 

wheel (see 2.7 – 2.8). The current tuning step is shown in the RX Control window to the left of 

the frequency dial and also in the Tmate 2 display. When the spinning speed exceeds a certain 

threshold, a multiplying factor of 5X is applied to the current step; this feature is quite 

common in traditional (hardware) receivers and transceivers. A further increment in speed 

triggers a 10X multiplying factor. The knob can be locked (see below). 

Pushing the tuning knob selects the current VFO (A – B). 

 

E1 ENCODER 

 

The function of this control can be selected by the user: pushing the knob selects the current 

function among the five available: 

 

- VOL adjust the VRX audio level (AF level or volume). 

- RFG adjust the AGC gain (if AGC is enabled) or the RF gain (if AGC is disabled). 

- SQL adjust the squelch threshold. 

- NR  adjust the amount of Noise Reduction 

- NB adjust the threshold of the Noise Blanker  

 

E2 ENCODER 

The function of this control can be selected by the user: pushing the knob selects the current 

function among the two available: 

 

- HIGH  adjust the selectivity filter high frequency limit. 

- LOW adjust the selectivity filter low frequency limit. 

 

Pushbuttons: 

 

F1 – DECREASE STEP 

 

This button decreases the tuning step to the next lower value (if available). 

 

F2 – INCREASE STEP 

 

This button increases the tuning step to the next higher value (if available). 

 

F3 – KNOB LOCK 

 

This button locks/unlocks the tuning knob; the locking status is indicated in the RX Control 

window, to the left of the frequency dial and by the LOCK LED on the Tmate 2 panel. 

 



F4 – ASSIGNABLE BUTTON 

 

The function of this button depends upon the current parameter controlled by the E1 encoder: 

 

- VOL MUTE on/off. 

- RFG AGC on/off. 

- SQL squelch on/off. 

- NR  Noise Reduction on/off. 

- NB Noise Blanker on/off (NBW only). 

 

F5 – RX MODE 

 

This button selects the current receiving mode. 

 

F6 – VRX SELECTION 

 

This button assigns the Tmate to the next VRX of the same instance. 

 

LEDs: 

 

USB LED 

 

This LED is lit when there is connection with the Tmate server. 

 

LOCK LED 

 

This LED is lit when the tuning knob is locked (see F3 button). 

 

LCD DISPLAY 

 

The Tmate 2 display shows many VRX parameters; the tuning frequency field also doubles as 

parameter value indicator. When the frequency exceeds the 9 digits capability of the display, 

the entire field is shifted one digit to the right (10 Hz resolution). 

 

 

10.0 Memory banks (from release 1.04 upwards) 

 

Starting from release 1.04, Studio 1 supports its own memory banks. 

Considerable efforts have been put into the development of such an important feature, in order 

to provide a powerful yet easy to use and efficient implementation. 

 

10.1 Basic concepts 

 

In Studio 1 each memory bank consists of a number of “memory locations”. 

Each memory location is composed of a number of data fields about a “reception channel” like 

frequency, description, RX mode and so on. 

Physically a bank is saved as a disk file and loaded in memory when needed. 

 

10.2 The memory bank file format 

 

Studio 1 uses its own extension (.s1b) for memory bank files but the file format itself is not 

proprietary: it is a common CSV text file, a format that can be easily handled by many 

software tools.  

 



10.3 GUI items added for memory banks management 

 

In order to implement memory banks, some GUI items have been added: 

 

- A new window, the “Memory Panel” that is the control center of all memory related 

operations. 

- A new button on the “Main” window labelled “MEM PAN”. 

- A new button on the “RX Control” window labelled “MCTR”. 

- Some new keyboard shortcuts. 

 

These new controls are described in the following chapters. 

 

10.4 The “Memory Panel” window 

 

The Memory Panel window is an instance resource: you can have one for each instance of 

Studio 1 (you actually need two of them in order to perform some advanced operations, more 

on this later); the window is resizable and its visibility parameters are stored in the workspace. 

To show the Memory Panel window click on the MEM PAN button on the Main window or 

press the B key from any window of the program.  

The Memory Panel is functionally split in two parts: the left part, also called the files pane and 

the right part also called the data grid.  

The files pane shows all the bank files in the current banks folder; you can quickly open one 

of the listed banks by double-clicking its name. On the bottom of the list a label shows the 

name of the currently loaded bank. The files pane can be hidden/shown with the CTRL+F 

keyboard shortcut or from the window context menu (mouse right-click); this setting is 

persistent (saved in the registry). 

The data grid is the key control: here the current bank data are showed in cells organized in 

rows (the memory locations) and columns (the data fields), much like some spreadsheet 

programs you have probably used. 

 

10.5 Memory data fields 

 

Currently each memory location includes 5 data fields: 

 

Frequency 

 

This is the most important field of course; frequency is expressed in Hertz up to 10 digits. 

If left blank the program will not change the tuning frequency of the relative VRX upon 

recalling.  

 

S (scan mode) 

 

This single character field is a flag for the Studio 1 scanning feature (not yet implemented); its 

purpose is to instruct the scanning system on what to do with that specific memory location. 

Allowed values are blank, Y and N. 

 

Mode 

 

This field indicates the RX mode for that memory location. 

Allowed values are: blank, AM, SAM, FM, CW, DSB, LSB, USB, and USER.  

If left blank the program will not change the RX mode of the relative VRX upon recalling. 

 

Description 

 

This field include an optional alphanumeric description of the memory location. 

The maximum length is undefined; however the grid editor for this field limits the input to a 

maximum of 255 characters. 

 



UTC 

 

This field can optionally include a description of when the relative channel is on-air, a feature 

usually included in many frequency databases. The format is XXXX-YYYY where XXXX is the 

start time and YYYY the stop time (UTC time); for example 0000-2400 means that the station 

is on air 24 hours a day. 

 

10.6 The data grid 

 

The data grid has the main purpose of showing data but it also provides many ways for 

editing. Inside the grid you can: 

  

- Scroll the bank data with the mouse wheel, scrolling bars or up-down arrow keys. 

- Customize the columns order. 

- Insert (add), delete, move and copy/paste rows. 

- Manually edit single cells. 

- Copy-paste single cells and cell selections. 

- Perform row sorting (ascending/descending) with a single click. 

- Search for specific data (incremental search). 

- Filter data  

 

Selected data fields are shown in yellow. 

The current active cell is highlighted with a brighter background. 

The current active row is shown by a small arrow marker shown in the row header. 

 

10.7 Basic operations in the data grid 

     

Customizing the columns order 

 

Per default the grid shows the columns in the same order as the relative data fields are stored 

in the bank file. However you might want to change the columns display order. 

To move a column to a new position click and drag the relative column header to the new 

position (a green arrow shows you the insertion point), then release the mouse button. 

Columns order is persistent (it is saved in the registry). 

 

You can’t change the columns width. 

 

Manual editing of cells 

 

In order to start manual editing of a cell you have two options: 

 

- Click on the relative cell then press F2. 

- Double-click the cell. 

 

The above operation starts the specific editor for that cell: 

 

- The Frequency field editor allows up to 10 numeric characters. 

- The Description field editor allows up to 255 alphanumeric characters. 

- The Mode and S field editors are of the combo-list kind: upon pressing the combo 

button you are allowed to select one of the values in the drop down list. 

- The UTC field editor allows up to 9 alphanumeric characters. 

 

To close the editor press the Enter key (combo-list editors close automatically upon selection). 

If the entry is invalid the cell shows the previous data. 

 



Manually inserting a new row 

 

New rows are always inserted after the current one. 

To manually insert a new (blank) row press the Ins key. 

 

Deleting a row 

 

To delete the current row press the Del key. 

 

Moving a row 

 

To move a row to a new location click and drag its header to the new location (a green arrow 

shows you the insertion point); finally release the mouse button. 

 

Copying a row 

 

If you don’t want to overwrite a previous row, first insert a new blank row to be used as the 

destination one. 

 

Select the source row by clicking its header. 

Copy to clipboard by CTRL+C shortcut. 

Now click the row header of the destination row.  

Paste from clipboard by CTRL+V shortcut. 

 

Copying a single cell 

 

Click on the source cell; copy to clipboard by CTRL+C. 

Click on the destination cell; paste from clipboard by CTRL+V. 

 

10.8 Bank file operations 

 

Changing the current Banks Folder 

 

The default Banks Folder is <Studio 1 exe path>\Mem_banks where: 

<Studio 1 exe path> is the path to the folder where the executable file of the current program 

instance resides. 

Mem_banks is a folder supplied with Studio 1; it includes some sample banks, showed in the 

files pane at first start. To change the Banks Folder, pop-up the context menu (right-click on 

the files pane or the grid) then choose Select banks folder; navigate to the new folder then 

click OK. The Banks Folder is persistent (it is saved in the registry). 

 

Opening a bank file 

 

The quick way to open a bank file is by double-clicking its name in the files pane. 

Another option is by the context menu Open bank option. 

 

Caution: in order to speed up operations, Studio 1 will not bother you with pop-up windows 

asking if you have saved your data. So if you made modifications to the current bank make 

sure to save it before loading a new one. 

 

The last used bank is automatically reloaded at the next program start-up. 

 

Saving a bank 

 

To save an already named bank choose Save bank from the context menu. 

If the bank is new (unnamed), Save bank starts a Save bank as… operation instead (see 

below).  

 



Saving a bank with a specific name 

 

This is the usual Save as operation: choose Save bank as… from the context menu. 

A save dialog window let you naming the file; if the file already exists a warning window pops-

up. 

 

Creating a new blank bank 

 

To create a new, blank bank choose New bank from the context menu. 

 

Caution: as for the Open bank option in order to speed up operations, Studio 1 will not bother 

you with pop-up windows asking if you have saved your data. So if you made modifications to 

the current bank make sure to save it before creating a new one. 

 

10.9 Recalling a memory location 

 

In this context recalling a memory location means assigning its Frequency and Mode 

parameters to a Studio 1 VRX. As an instance of Studio 1 can have more than one VRX you 

need a way to tell the Memory Panel which is your “target” VRX: this is the purpose of the 

MCTR button on the RX Control window. The MCTR button “connects” a specific VRX to the 

Memory Panel for some operations. A mutual exclusion logic is implemented: only one VRX can 

be assigned at a given time (inside the same application instance).  Once a VRX is “connected” 

recalling a memory location is straightforward: simply click on any cell of the wanted memory 

location (row). 

 

10.10 Storing to a memory location 

 

Storing to a memory location imply first inserting a new blank row after the current one, filling 

some fields automatically and finally making that row the current one in preparation for the 

next operation. The program fills the Frequency and Mode fields with data from a specific VRX. 

You have different options to perform the above operation: 

 

Storing from a VRX with the MCTR button active 

 

- Click on the STORE button on the Memory Panel. 

- Alternative way: use its keyboard shortcut CTRL+S (the Memory Panel window must 

have the focus). 

 

Storing from a VRX that has the focus regardless of the MCTR button status 

 

- Use CTRL+S (one of the VRX windows must have the focus). 

 

10.11 Importing from other database formats 

 

In a near future Studio 1 will be capable of importing data from all the most used frequency 

databases. Currently the Import feature only works for EiBi database files (CSV format) and 

Perseus “Userlist” (*.txt) files. 

In order to import from a database chose Import from the context menu, then select one of 

the import options. Locate the source file and click Open. The import process takes a couple of 

seconds (depending on the length of the database and your PC processing power). 

The bank thus created can be saved as a Studio 1 regular bank file. 

 



10.12 Advanced editing operations 

 

Sorting the memory bank 

 

You can sort the loaded memory bank using any of the data fields as the main sorting key. 

To perform ascending sorting, click on the column header of the field you wish to use as the 

key. Click again to perform descending sorting. A further click undoes the sorting. 

An arrow indicator shows up in the column header used for sorting; it points upward to 

indicate an ascending sort and downward for a descending sort. 

A sorted bank can be saved in its state if needed. 

 

Searching the memory bank 

 

Sometimes you might have to search a large bank for a specific word occurrence. 

To activate the search function choose Find… from the context menu; a search footer 

appears. The search footer provides you with familiar functions to perform incremental search; 

as you type your text in the search edit box the search process refines. Use the Next-

Previous buttons to navigate among multiple occurrences of the same word. 

Until the Match case option is checked search is case-insensitive.  

 

Selecting and copying multiple cells 

 

It is possible to copy multiple cells at a time; to perform a multi-cell selection click on the 

upper left cell and drag to the right lower cell of the selection area (selected text turn to 

yellow). Then you can copy and paste the entire selection using the clipboard shortcuts already 

seen (CTRL+C, CTRL+V). 

 

Creating a composite bank from several source banks  

 

You can copy-paste from the Memory Panel of a given Studio 1 instance to the one of another 

instance; this capability allows complex editing operations like the composition of a bank 

including data from different “source” banks, without the need of a specialized tool.  

You only need another Memory Panel from a second Studio 1 instance. 

Simply apply all the editing operation already seen but this time using one Memory Panel 

instance as the source and the other as the destination. 

 

10.13 Filtering data 

 

Filtering a data bank means showing only the rows that match filtering criteria. 

Currently you can only filter by VRX frequency. To enable this options choose Filter by VRX 

freq. from the context menu. The data grid is updated after every frequency change; since 

filtering a large data bank is a CPU intensive operation, the program waits until it detects that 

the tuning operation has ended, and then performs the filtering. If no VRX is assigned to the 

Memory Panel (see 10.9), no filtering occurs. Filtering is disabled when choosing one of the 

following options: 

 

- New bank 

- Import 
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